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1. INTRODUCTION 

This document describes how to install and operate the Pee Dee River and Atlantic 

Intracoastal Waterway Salinity Intrusion Model (PRISM). The PRISM is a decision support 

system (DSS) built around a suite of empirical hydrologic models of the study area (fig. A1). 

Hydrologic behaviors in the study area have been measured at a number of gaging stations 

operated by the U.S. Geological Survey (USGS) since the mid 1980s.  

Figure A1. Study area showing USGS gage locations where flow, water level, and 

specific conductance were measured. 
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2. INSTALLATION 

1.	 Create a folder called “PRISM” at the top level of your C: drive. 

2.	 Extract all files from the distributed PRISM-yyyymmdd.zip1 file. The WinZip™ file contains 

the following application files: 

PRISM-yyyymmdd.xls – a Microsoft Excel™ (Excel) spreadsheet application. 

18 files with an “.enn” extension – these are the artificial neural network (ANN) files. 

NNCALC32.xll – a custom Excel add-in used to execute the *.enn files. 

PRISMUserGuide-yyyymmdd.doc – the Microsoft Word™ file that you are reading right 

now. 

ReadMe.txt – a text file with these installation instructions. 

3.	 Open your copy of Microsoft Excel™ for Office 2000™ (Excel). The version of Excel must 

be 2000 or newer. Ensure that the standard Excel Add-Ins listed below are installed and 

checked “available.”  

Analysis Toolpak 

Analysis Toolpak – VBA 

Add-Ins are accessed from Excel’s Tools menu. If any are missing, it may be necessary to 

install them from your Microsoft Office CD-ROM. 

4.	 Set the macro security level of Excel to either medium or low using Tools > Macro > 

Security. PRISM uses VBA macros for a variety of purposes and must be able to execute 

them to operate correctly. 
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5.	 Install the NNCALC32 custom Excel add-in that resides in the NNCALC folder described in 

Step 2. This may be accomplished by clicking on Tools > Add-Ins > Browse, then browsing 

to the PRISM folder you created, clicking on the NNCALC32 icon, then clicking OK. 

6.	 Open the PRISM-yyyymmdd.xls Excel spreadsheet application. When Excel asks if you 

want to run macros click “Enable Macros,” otherwise PRISM will not operate correctly. 

Select the “Run” worksheet (fig. A2). “Run” is the graphical user interface (GUI) component 

that allows the user to set up and run simulations. At the top of “Run” is a text box labeled 

“Where Model Files are Located.” The model files are the *.enn files. Type in the fully 

qualified path name of the folder set up in Step 1 above and save the Excel application using 

File > Save for the set up changes to be permanent. 

At the lower left of the “Run” worksheet are a number of columns having headers 

containing SC (specific conductance). If any of the SC-related fields show numerical values 

and not “?” or an Excel or NNCALC32 error code, the application is properly configured and 

ready to use. If all of the SC-related fields show “?” or an error code, exit Excel™ and reload 

Excel and the PRISM application. 

An error code indicates that an ANN cannot execute because either the NNCALC32 add-

in is not installed per Step 5 or NNCALC32 cannot find *.enn files because the folder path 

name in the “Where Model Files are Located” text box is incorrect.  

If you cannot get PRISM to operate, re-check the configuration items in Steps 3-6 above.  

1 yyyymmdd is the version date of the PRISM application to be installed. 
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Figure A2. The “Run” worksheet, a component of Pee Dee River and Atlantic 

Intracoastal Waterway Salinity Intrusion Model graphical user interface. 

3. REMOVAL 

Simply delete the folder created to hold the PRISM files and its contents. 

4. OPERATION 

PRISM is opened like any standard Excel workbook. Simply open the PRISM­

yyyymmdd.xls file and begin. PRISM and its GUI include a number of worksheets that are 

detailed in the following sections. 
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4.1. Variable Descriptions, Nomenclature, and “ReleaseNotes” Worksheet 

PRISM refers to many input and output variables, usually in the form of column headers 

(fig. A3). Moving the cursor over a header marked with a red caret immediately above and to the 

right of the header will provide a description of the header variable.  

Figure A3. Description of the variable QOTHERDm on the “Run” worksheet. 

Descriptions of variables are provided in the “ReleaseNotes” worksheet. This worksheet 

also describes PRISM’s development history and any new features or changes. 

Some of the prefixes, suffixes, and other modifiers that are used in variable names include: 

“D,” used as a suffix to indicate that a variable is a “daily” or 24-hour average; 


“d,” used as a prefix to indicate that a variable is a difference between two variables’ values; 


“p,” used to indicate that the variable is a model prediction; 


“m,” used to indicate that a variable’s value is either, 


o an actual measurement or 

o a model prediction made using an actual Q131000 measurement as an input value; 

“u,” used to indicate that a variable’s value is either  

o a user-set or optimizer-set Q131000 value or 
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o a model prediction made using a user-set or optimizer-set Q131000 input value. 

4.2. “Info” Worksheet 

The “Info” worksheet is automatically displayed when PRISM is first loaded (fig. A4).  It 

contains the program’s version date and the contact information of its developers. 

Figure A4. The “Info” worksheet. 
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4.3. “Run” Worksheet 

The “Run” worksheet (fig. A2) is the GUI component that allows the user to set up and 

run simulations. At the top of “Run” is a text box labeled “Where Model Files are Located.” The 

textbox is used to configure PRISM when it is first installed on a user’s computer and is 

described further in section 2. As shown in figure A5, start and end dates for simulations can be 

set by using the controls at the upper left.  The end date must be more recent than the start date. 

The “Time Step” can be set to either 1 hour or 24 hours. PRISM simultaneously calculates both 

daily average and hourly SC. The “Sim Time” text box indicates the time stamp that is providing 

the current input values to PRISM’s models. 

Figure A5. Simulation controls on “Run” worksheet. 

In the “Step / Run” controls at the upper right in figure A5, “<<Step” and “Step>>” move 

the current time stamp backward or forward one time step. “Sim Time=Start” sets the current 

time stamp to the simulation “Start” date. “RUN” will start and run a simulation between the 

dates indicated by the simulation “Start” and “End” dates. “Opt All SC” will, for the current time 

stamp, run the optimizer for those gages designated by their “Q13100D Input Option” (fig. A2) 

to use the optimizer. 
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On a separate worksheet for each gage, PRISM provides detailed numerical and 

streaming graphical information that can be observed during simulations or when incrementally 

stepping through time. This allows the user to examine specific periods and behaviors of interest 

in detail. PRISM also will write input and output data to the “Output” worksheet. Because of the 

added computational load, simulations are slowed when streaming graphics and simulation 

output are generated. The “Graphs ON” and “Write Output” check boxes of the “Output” 

controls at lower center right in figure A5 allow the user to toggle the streaming graphics on or 

off. The “Clear Output” button erases all data in the “Output” worksheet to allow data from a 

new simulation to be recorded. 

A simulation may be stopped at any time during a run by holding down the “Esc” key, 

after which a pop-up window will appear like the one shown in figure A6. Click on the “End” 

button to stop the simulation, then click the “RESET” button shown at the lower right in figure 

A5. The “RESET” button activates Excel’s™ automatic calculation feature (autocalc). Because 

the model programmatically manipulates autocalc for performance reasons, aborting a simulation 

can sometimes leave the model in a state where autocalc is not activated. This is remedied by 

clicking the “RESET” button. 
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Figure A6. Pop-up window that appears when a simulation is interrupted using 

the “Esc” key. 

Figure A7 shows that there are a number of input options for the models of each gage. By 

column from left to right: 

“Gage:” denotes the gage options, setpoints, measurements, and predictions in the rows to the 

right in the “Run” worksheet. The "D” (daily average value) and the "H” (hourly value) label 

the “SC SP,” “SCm,” “SCp(m),” “SCp(u),” “dSC(pu-pm),” and “SCm/p+dSC” fields. 

“Q13100D Input Option:” Options listed below are shown above slider bar. Only “%” is 

shown in figure A7: 

o	 “%:” percent of historical flow 

o	 “ft3/s:” fixed flow rate in units of cubic feet per second 

o	 “usrHyd:” uses the user-defined hydrograph pasted into the UserQ13100D worksheet by 

the user 

o	 “LimitD:” the optimizer is engaged when the daily average SC at the gage exceeds the 

SC setpoint set on the “SPs” worksheet (see section 4.4) 
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o	 “LimitH:” the optimizer is engaged when the hourly SC at the gage exceeds the SC 

setpoint set on the “SPs” worksheet  

o	 “OptD:” the optimizer is engaged continuously to hold daily average SC at the gage to 

the SC setpoint set on the “SPs” worksheet  

o	 “OptH:” the optimizer is engaged continuously to hold daily average SC at the gage to 

the SC setpoint set on the “SPs” worksheet 

“Q13100D Inputs By Option:” the potential user-set Q13100D values input to each gage’s 

model pair. The actual value used depends on the “Q13100D Input Option” setting. 

o	 “%:” shows the “%” setpoint value set on the “SPs” worksheet 

o	 “ft3/s:” shows the “ft3/s” setpoint value set on the “SPs” worksheet 

o	 “usrHyd:” shows the value given for the current time stamp in the user-defined 

hydrograph on the UserQ13100D worksheet 

o	 “Opt:” shows the value computed by the optimizer to meet the SC Setpoint set on the 

“SPs” worksheet 

Q13100Du: the input value used according to the “Q13100D Input Option” setting. 

QOTHERDm: sum of measured unregulated inflows = Q5000D + Q13200(•=48 hrs) + 

Q13500 + Q13600(•=24 hrs). 

QTOTDu: total inflow = Q13100Du(•=24 hrs) + QOTHERm 

“SC SP:” Daily and hourly SC setpoints as set on the “SPs” worksheet. The setpoint used is 

per the Q13100D Input Option. 

“SCm:” measured daily and hourly SC 

“SCp(m):” predicted daily and hourly SC using the measured Q13100D for input 

“SCp(u):” predicted daily and hourly SC using the Q13100Du for input 
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“dSC(pu-pm):” = SCp(u) – SCp(m) 


“SCm/p+dSC:” = SCm + dSC(pu-pm) if SCm is not missing, else = SCp(m) + dSC(pu-pm) . 


Figure A7. Input options and values for each gage. 

4.4. “SPs” (Setpoints) Worksheet 

The upper portion of the “SPs” worksheet is the component of PRISM’s GUI that allows 

the user to set flow and SC setpoints (fig. A8). The actual setpoint used for each gage is 

determined by the “Q13100D Input Option” selected on the “Run” worksheet. At the left of the 

“SPs” worksheet are controls that allow the “%” (of historical) Q13100D and the constant valued 

“ft3/s” Q13100D setpoints to be set for each gage. At the right are the controls for setting the SC 

daily (D) and hourly (H) setpoints. The historical daily and hourly maximum and minimum SCs 

are provided for reference. Maximum and minimum allowed SC setpoints, which are constraints 

on the optimizer derived from the historical daily and hourly maximum and minimum SCs, also 
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are given. A “hard-coded” optimizer constraint is that Q13100D is limited to a maximum of 

15,000 ft3/s. 

Figure A8. Upper portion of the “SPs” worksheet showing headings of the 

controls and variables. 

4.5. “Database” and “Output” Worksheets 

The “Database” worksheet contains the time series data used by PRISM to run 

simulations (fig. A9). These data are described in table A1 and are derived from the raw field 

measurements. They are augmented by calculated variables whose values are calculated by 

PRISM’s computer code. The user should not alter data in the “Database” worksheet. 
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Figure A9. Example of measured data from the “Database” Worksheet. 
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Table A1. Descriptions of variables written to the “Output” worksheet during 

simulations. 

The “Output” worksheet contains a record of key variables for a particular simulation run 

(fig. A10). The “Write Output” check box on the “Run” worksheet (fig. A2) must be checked for 

output to be written. The variables written to the “Output” worksheet are explained in table A1. 

The user can copy output values into another Excel workbook for further analysis.  
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Figure A10. Example output from the “Output” worksheet. 

4.6. Gage-Specific Worksheets "815," "8125," "8135," "812," "809," "777," "770," 

"755," and "766" 

PRISM provides streaming numerical and graphical output for each gage on a gage-

specific worksheet (fig. A11) and can be observed during simulations or when incrementally 

stepping through time. This allows the user to examine specific periods and behaviors of interest 

in detail. Some of the functionality of the gage-specific worksheets also is found on the “Run” 

worksheet that represents all of the gages. 
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 The “<<Step,” “Step>>,” “Sim Time=Start,” “RUN,” and “RESET” buttons on the “Run” 

worksheet are described in section 4.3. The “Opt SCXXXXD” and “Opt SCXXXXH” buttons 

are similar to the “Opt All SC” button on the “Run” worksheet and will, for the current time 

stamp, run the optimizer for the gage according to the “Q13100D Input Option” settings on the 

“Run” worksheet. 

The settings and numerical information below the buttons are the same as those on the  “Run” 

worksheet and are described in section 4.3.   

The graph at the lower left of the gage-specific worksheet shows the daily and hourly time series 

of the inputs to the gage’s model pair. The gages to the south in the study area, "815," "8125," 

"8135," "812," and "809," have inputs representing wind speed and direction in addition to those 

representing flow (ft3/s), water level (WL), and tidal range (XWL). The graph at the lower right 

shows the daily and hourly SC-related measurement and prediction time series. The graphed 

variables are described in table A1. 
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Figure A11. Example gage-specific worksheet (815). 

4.7. “3DVis” Worksheet 

PRISM’s “3DVis” worksheet provides graphical SC profiles at the south and north ends 

of the study area (fig. A12). It is designed to visualize periods of special interest, selectable using 

the “Start” and “End” date controls and initialized using the “Sim Time=Start” button on the 

“Run” worksheet. On the left side of the 3DVis worksheet are data and the controls for operating 

the 3DVis worksheet. The data is a subset of that on the “Run” worksheet and is provided for 

reference while using the 3DVis worksheet. The “Vis. Daily or Hourly” control is used to select 

either daily or hourly SC for visualization. The “<<Step,” “Step>>,” “RUN,” “Sim Time=Start,” 

“RESET,” “Time Step (hrs),” and “Graphs ON” buttons and controls are the same as those used 
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in the “Run” worksheet and are described in section 4.3. Animations can be started using the 

“Run” button if the “Graphs ON” check box is checked in the “Run” worksheet. 

Figures A12 and A13 show that two plots are created for each of the south and north ends 

of the study area. The left plots show the SC profile representing the actual historical data (when 

available), and the right plots show the profile predicted by the gage model pairs using the user-

specified Q13100Du. Note that the predicted profiles are only meaningful if the models are set to 

use exactly the same input Q13100Du. For example, the plots shown in figures A12 and A13 

were created using all models with settings “Q13100Du Input Option” = “%” on the “Run” 

worksheet and “Q13100D” “%” setpoints on the “SPs” worksheet = 80 (%). 

Figure A12. The “ 3DVis” worksheet showing specific conductance at south end 

of study area. Note shortened gage numbers and locations. Here, the Q13100Du 

setting is 80% of historical. 
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Figure A13. The “3DVis” worksheet showing specific conductance at north end 

of study area. Note shortened gage numbers and locations. Here, the Q13100Du 

setting is 80% of historical. 

5. TECHNICAL ASSISTANCE 

Please contact Paul Conrads of the USGS at (803) 750-6140, pconrads@usgs.gov, if you have 

problems with this model. 
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